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Introduction

This Interface was created after the examination of an existing VHDL module (source unknown).
Since this module was poorly coded and had no test bench, | wrote this small project in a couple of
hours to let it be used as a real interface, and for teaching purpose.

| kept the original architecture (after some fixings in the VHDL style) under the name “Plain_Wrong”
and wrote a new one under the name “ALSE_RTL". Obviously, only the latter should be used !
“Plain_wrong” is left to compare both solutions and understand what errors were made (I inserted a
few hints).

| have then developed a more sophisticated controller (with bi-directional communication), which
should probably be adopted in a serious design. If you are interested, please contact ALSE at

mailto:info@alse-fr.con.

As usual (especially for such simple functions), there is more complexity and more value in the
simulation code (self-testing VHDL Test Bench) than in the RTL code. The test bench does include
a behavioural model for a PS/2 Keyboard (transmit only).

However, the structure used for the RTL description is suitable and efficient for much more complex
tasks. It should be also very simple to add extra features to the code provided. As this is often the
case, the “clean” solution is as compact (or more) than the “dirty” solution, it has more features
(Parity + Overflow + Stop Bit errors detection), and it is easier to enhance or modify.

Features

Fully synchronous solution: one clock, one global reset.

Suitable for PS/2 peripherals (keyboard, mouse...).

PS/2_Clock is filtered digitally.

Parity is verified

Overflow detection (when the host does not read the value received in time).
ALSE_RTL2 architecture only: timeout protection (against incomplete or wrong frames)

Simplified interface: the host does not send data to the peripheral, it can only receive data. This
is viable for a Keyboard (though the LED indicators NumLock, ScrollLock, CapsLock can only be
changed by the host). This poses more problem with the recent mice which require a complex
dialog with the host before operating in the expected way.

For details about the PS/2 serial bus format, please refer to some of the abundant literature
widely available. There is a good article from Adam Chapweske available at :
http://govschi.ndsu.nodak.edu/~achapwes/PICmicro/PS2/ps2.htm

in which information can be found on the connectors and cabling, the hardware interface, the

protocol, details on mouse and keyboard data, etc...

YV VYV YV VY

Note: we have left the digital filter on PS2_Clk though appropriate hardware (Schmidt trigger) should
be used to ensure that the signal has steep enough edges, in which case a simple re-synchronizing

+ synchronous edge detection (2 Flip-Flops) would suffice. The larger of the shift register used as a

digital filter could/should be reduced when the system clock is very slow (like 1 MHz or less).

This module can also be used as a transparent “spy”, to listen to the traffic on a PS/2 port.

© ALSE - |http://www.alse-fr.coni 1


http://www.alse-fr.com
http://www.alse-fr.com
mailto:info@alse-fr.com
http://govschl.ndsu.nodak.edu/~achapwes/PICmicro/PS2/ps2.htm

Module Description
PS2_CTRL
DoRead Scan_DAV——

The graphic symbol of the Controller is PS2_Clk Scan_Err
represented on the right, with inputs on PS2_Data  Scan_Code[7:0]——
the left side, and outputs on the right Clk—Clk
side. Reset—— Reset
R H d d h d | l----------|3- ------------
eset IS used Inside the module http://www.alse-fr.com
as an asynchronousand ~ FosEsmossomesemoe oo
global reset.
Clk is the sole clocking source for all the Flip-Flops (fully synchronous design).
PS2 Clk, and

PS2 Data  are the two signal lines of the PS/2 Interface.
They are inputs (only) to our module.

DoRead is an input pulsed by the user when the Data out code is read.
This clears the Scan_DAYV bit.

The outputs are:

Scan_DAV Goes to 1 when a word has been received. Remains there until DoRead is asserted
then goes low at the next clock cycle.

Scan_Err Is set when the data received is incorrect (parity, stop...) or when there is an overflow
(user has not read the previous code in time). This flag is automatically cleared when
the reception of a new character begins.

Scan_Code (8 bits) is the data word received.
The value remains stable until the next word is received.

Cosmetic note: the naming “Scan_xxx" is very appropriate when a keyboard is attached, but makes
less sense when a mouse is attached.

Implementation

Please refer to the widely available PS/2 documentation to fully understand the specific serial
protocol. You will notice that, when the host is only reading (and does not send data), the basic
function to accomplish is to sample the Data line just after each Clock line’s falling edge.

This determines a word made of 11 bits, including in this order a Start bit (=0), the 8-bits code
(appearing LSB first), an Odd parity bit, and a Stop bit (=1). See the waveform next page.

The most compact solution one could imagine would be asynchronous, and we will indeed avoid
this bad practice! Our solution is fully synchronous. We have implemented a small filter on the
PS2_CIk line: we sample it at the system clock rate and wait for 8 consecutive identical samples
before accepting the value. The number “8” is a generic parameter and can be easily changed.
For values above 8, a different and more efficient implementation of this filter (based on a counter)
should be used. When ad-hoc hardware is used (Schmidt-trigger logic on the PS2 lines) this could
be simplified into a standard synchronous edge detector. Note however hat a bounce (or glitch) on
the PS2_Clk line would be catastrophic (it would desynchronize the frame).

The reception of the frame is quite simple since we use a 2-states FSM.

When you connect a device, make sure (1) that there is a Pull-Up resistor somewhere on each PS/2
line (both Clock and Data) and (2) that the resistors’ value is adequate. A too high value can create
lazy rising edges, which may in turn create problems on the FPGA side. You may find that your
keyboard already has pull-up resistors wired.
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Simplest Application

For very simple applications, or when the user modules are capturing the arriving Data without
delay, it is possible to connect Scan_DAV to DoRead.

Since the output code remains stable, it is then possible to build a very simple application:

Scan_DAV
L PS2_CTRL
DoRead Scan_DAV LED

PS2_Clk PS2_Clk Scan_Err o1 ED

PS2_Data PS2_Data Scan_Code[7:0] Code[7:0] Vee SEVENSEG

Clk “T_pgl MSD
Reset Reset
PS2 CTRL | Code[7:4——Data[3:0] Segout[1:7] D7SEG_HI[1:7
FILTERSIZE : POSITIVE :=8 Dec7SegH

__________________ . Use Gnd on Pol is LED is active high

"""""""" vee SEVENSEG

. . . T lpol LSD
SImpIeSt PS/Z Appllcatlon Code[3:0—Data[3:0] Segout[1:7]———[D7SEG_L[1:7] >

Dec7SegL

The VHDL code for the schematics above is included, and can be tried on any FPGA/CPLD board.
It was tried on an old Lattice CPLD board and on an XESS board (XS40-010XL) and worked directly
on both. Tek Prevu | L ]

v

m»ﬁwﬂmhmmmﬂ«—mw‘wm.“".

If you connect a keyboard to PS2_Clk and

PS2_Data (and power the keyboard with +5Vdc), _
pressing or releasing a key should display the : g
corresponding scan code. Verifying first these : chi Freq
signals with an oscilloscope is definitely a good L R - s
idea, if only to verify the rising edges’ slope.

Note that lighting the keyboard’s LED indicators 2 A e m—i—
(CapsLock etc...) would require the PS/2 :
Controller to actually send data to the keyboard.
This feature (*host to device” communication) is b
not available in this simple controller. This would a0y 28 Apr 2002
require bi-directional I/Os for PS2_Data and i+~ [368.00045 | 08:26:28
PS2_CIk (and appropriate control logic indeed).

Note also that when you depress a key, the keyboard issues two codes in sequence: x“F0” followed
immediately by the key’'s scan-code. Since we display the codes on the LEDs when they arrive
(without extra delay), you will probably miss the FO and only observe the scan code.

A more sophisticated application could ignore scan codes preceded by x"F0”, or handle a matrix of
128 bits where each bit represents the status of one key (pressed, not pressed), etc...

If you connect a mouse, then you need to handle the incoming codes in a much different manner,
and this is outside the scope of this document. Just be aware that you will also need to send
information to the mouse, which this version of the controller cannot do.

This trivial application can help verify that the hardware is correctly connected and in working order.
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PS/2 Controller Source code (correct architecture only)

-~ PS2_Ctrl.vhd
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is_inmplenented !
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l'ibrary | EEE;
use | EEE. STD LOG C 1164. al | ;
use | EEE. Nuneric_std. al l;

generic (FilterSize : positive := 8);

port( CKk :in std_logic; -- System dock
Reset :in std_logic; -- System Reset
PS2_d k :in std_logic; -- Keyboard O ock Line
PS2_Dat a in std_logic; -- Keyboard Data Line
DoRead :in std_logic; -- Fromoutside when reading the scan code
Scan_Err : out std_logic; -- To outside : Parity or Overflow error
Scan_DAV : out std_logic; -- To outside when a scan code has arrived
Scan_Code : out std_logic_vector(7 downto 0) -- Eight bits Data Qut

)
end PS2_Ctrl;

-- Author : Bert Cuzeau.

-- Fully synchronous solution, sanme Filter on PS2_C k.

-- Still as conpact as "Plain_wong"...

-- Possible inprovenent : add TIMEQUT on PS2_C k while shifting

-- Note: PS2_Data is resynchronized though this should not be

-- necessary (qualified by Fall _C k and does not change at that tine).
-- Note the tricks to correctly interpret '"H as '1'" in RTL sinulation.

signal PS2_Datr : std_logic;

subtype Filter_t is std_logic_vector(FilterSize-1 downto 0);

signal Filter . Filter _t;

signal Fall_Cdk : std_logic;

signal Bit_Cnt : unsigned (3 downto 0);
signal Parity : std_l ogic;

signal Scan_DAVi : std_logic;
signal S Reg . std_logic_vector(8 downto 0);
signal PS2_dk_f : std_logic;

Type State_t is (ldle, Shifting);
signal State : State_t;

begin
Scan_DAV <= Scan_DAVi ;

-- This filters digitally the raw clock signal comng fromthe keyboard :
-- * Eight consecutive PS2_C k=1 nakes the filtered_clock go high
* Eight consecutive PS2_C k=0 makes the filtered_clock go | ow
-- Inmplies a (FilterSize+l) x Tsys_clock delay on Fall _Ck wt Data
-- Also in charge of the re-synchronization of PS2_Data

process (d k, Reset)
begin
if Reset="1" then
PS2_Datr <="'0";
PS2_ Ak _f <="'0";
Filter <= (others=>'0");
Fall _dk <="'0";
elsif rising_edge (CAk) then
PS2 Datr <= PS2 Data and PS2 Data; -- also turns '"H into '1'
Fall _dk <="'0";
Filter <= (PS2_d k and PS2_CLK) & Filter(Filter'high dowto 1);
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if Filter = Filter_t'(others=>'"1") then
PS2 Ak f <="'1";
elsif Filter = Filter_t'(others=>"0") then
PS2 Ak f <="'0";
if PS2.Adk_f ="1" then
Fall _dk <="'1";
end if;
end if;
end if;
end process;

-- This sinple State Machine reads in the Serial Data
-- comng fromthe PS/ 2 peripheral.

process(d k, Reset)

begin
if Reset="1" then
State <= | dle;
Bit _Cnt <= (others => "'0");
S Reg <= (others => "'0");

Scan_Code <= (others => '0");
Parity <="'0";
Scan_Davi <= '0'";
Scan_Err <="'0";

elsif rising_edge (CAk) then
if DoRead='1' then
Scan_Davi <= '0'; -- note: this assgnmt can be overriden
end if;

case State is

when Idle =>

Parity <="'0";

Bit_Cnt <= (others => "'0");

-- note that we dont need to clear the Shift Register

if Fall _dk=1 and PS2_Datr="0" then -- Start bit
Scan_Err <= '0";
State <= Shifting;

end if;

when Shifting =>
if Bit_Cnt >= 9 then
if Fall _Cdk="1 then -- Stop Bit
-- Error is (wong Parity) or (Stop='"0") or Overflow
Scan_Err <= (not Parity) or (not PS2_Datr) or Scan_DAVi;
Scan_Davi <= "1';
Scan_Code <= S Reg(7 downto 0);
State <= |dle;
end if;
elsif Fall_Ck="1" then
Bit Cht <= Bit Cnt + 1;

S Reg <= PS2_Datr & S Reg (S _Reg' high downto 1); -- Shift right
Parity <= Parity xor PS2_Datr;
end if;
when others => -- never reached
State <= Ildle;
end case;
end if;

end process;

end ALSE RTL;
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Unitary Test Bench Source code

-- KBD_TST. vhd

-- Author : Bert Cuzeau - ALSE - Rftp: /7 www al'se€-Tr. com
-- No part of this code can be used w thout the prior
-- witten consent of ALSE.

-- This is a sinplified nodel .

-- Conpile with '93 option (hex constants...)

use STD. Textio. all;
l'ibrary | EEE;
use | EEE. Std_Logi c_1164. al | ;
use | EEE. Nuneric_std. al |l ;
use | EEE. Std_Logi c_Textio.all;

entity Kbd_tst is

constant Period : time 1= 40 ns; -- 25 MHz System O ock
constant BitPeriod : tinme := 60 us; -- Kbd dock is 16.7 kHz nmax
end;

architecture Test of Kbd_tst is

Component PS2_Ctrl

port( CKk in std_logic; -- System d ock
Reset > in std_logic; -- System Reset
Kbd_dC k :in std_logic; -- Keyboard d ock Line
Kbd_Dat a in std_logic; -- Keyboard Data Line
DoRead in std_logic; -- Fromoutside when readi ng the scan code
Scan_Err : out std_logic; -- To outside if wong parity or Overflow
Scan_DAV : out std_logic; -- To outside when a scan code has arrived
Scan_Code : out std_logic_vector(7 dowto 0) ); -- scan code

end conponent;

signal dk std_logic :="'0";

si gnal Reset std_| ogi c;

signal Kbd_d k std_logic :="H;

signal Kbd_Dat a std logic := "H;

si gnal DoRead std_logic :="'0";

signal Scan_Err std_| ogi c;

signal Scan_DAV : std_| ogic;

signal Scan_Code : std_|ogic_vector(7 downto 0);

signal Succeeded : bool ean : = true;

type Code r is
record

Cod : std_logic_vector (7 downto 0);

Err : Std_logic -- note: '1l'" <=> parity error
end record;

type Codes_Table t is array (natural range <>) of Code_r;
constant Codes_Table : Codes_Table_t -- if you need nore codes: just add them

= ( (x"A5","'0"), (x"BA",'0"), (x"00",'0"), (X"FF',"0"),
(x"12",'0"), (x"34",'0"), (x"56","1"), (x"56",'0"),
(x"78",0"), (x"BC',"0") );
-- in Verilog, the function belowis just : "V i)
function Even (V : std_logic_vector) return std_logic is
variable p : std_logic :="'0";
begin
for i in Vrange loop p :=p xor V(i); end |loop; return p;

end function;
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-- Instanciate the UUT (PS/2 Controller)
UUT: PS2_Ctrl
port map ( Ak = d Kk,

Reset => Reset,
Kbd_d k => Kbd_d k,
Kbd_Data => Kbd_Dat a,
DoRead => DoRead,
Scan_Err => Scan_Err,
Scan_DAV => Scan_DAV,
Scan_Code => Scan_Code );

-- System O ock & Reset

Ck <= not dk after (Period / 2);

Reset <= "1', '0' after Period;

-- Keyboard sending Data to the Controller
Emt: process

(7 downto 0);

procedure SendCode ( D : std or
: std "0') is

Err
begi n
Kbd Ok <="'H;
Kbd Data <= 'H ;
-- (1 verify that Gk was ldle (high) at least for 50 us.
-- this is not coded here.

wait for (BitPeriod / 2);
-- Start bit
Kbd_Data <= '0';
wait for (BitPeriod / 2);
Kbd Ok <="'0"; wait for (BitPeriod / 2);
Kbd_ Ok <="'1";
-- Data Bits
for i in0Oto 7 |oop
Kbd_Data <= D(i);
wait for (BitPeriod / 2);
Kbd_ Gk <="'0"; wait for (BitPeriod / 2);
Kbd Ok <="'1";
end | oop;
-- Odd Parity bit
Kbd_Data <= Err xor not Even (D);
wait for (BitPeriod / 2);
Kbhd_Ok <="'0"; wait for (BitPeriod / 2);
Kbd Ok <="'1";
-- Stop bit
Kbd_Data <= '1';
wait for (BltPerlod/ 2);
Kbd dk <="'0"; wait for (BitPeriod / 2);
Kbd_ Ok <="'1";
Kod_Data <= 'H ;
wait for (BitPeriod * 3);
end procedure SendCode;

begin -- process Emt

VWit for BitPeriod;

-- Send the Test Franes

for i in Codes_Tabl e' range | oop

SendCode (Codes_Tabl e(i). Cod, Codes_Tabl e(i).Err);
end | oop;
if not Succeeded then

report "End of simulation : " & Lf &

There have been errors in the Data / Err read !"
severity failure;
el se
report Lf & " SUCCESSFULL End of simulation : " & Lf &
" There has been no (zero) error !'" & Lf & Ht
severity note;
report "End of Sinulation" severity failure;
end if;

end process Enit;
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-- Host reading (& verifying) Data :

Host: process
variable L : |ine;
variable Index : natural := 0;
begi n
wait until Scan_DAvV='1";
wait for 300 * Period
DoRead <= '1';
wite (L, nowright,12);
wite (L, H & Scan code read (hex) =");
hwite (L, Scan_Code);
if Scan_Err="1" then
wite (L, ht& >>> Scan_Err <<<");
end if;
-- Conpare with the original Data-Error
if (Scan_Code /= Codes_Tabl e( 1 ndex) . Cod)
or (Scan_Err /= Codes_Tabl e(lndex).Err) then
Succeeded <= Fal se;

wite (L, H&!!'l Msmatch !!1!1");
end if;
Index := Index + 1

witeline (output,L);
wait for Period,
DoRead <= '0'

end process Host;

end Test;

When the simulation runs, the following messages appear in the simulation transcript:

--# 732380 ns Scan code read (hex) = A5
--# 1602380 ns Scan code read (hex) = 5A
--# 2472380 ns Scan code read (hex) = 00
--# 3342380 ns Scan code read (hex) = FF
--# 4212380 ns Scan code read (hex) = 12
--# 5082380 ns Scan code read (hex) = 34
--# 5952380 ns Scan code read (hex) = 56 >>> Scan_Err <<<
--# 6822380 ns Scan code read (hex) = 56
--# 7692380 ns Scan code read (hex) = 78
--# 8562380 ns Scan code read (hex) = BC

--# ** Note:

--# SUCCESSFULL End of sinulation :

--# There has been no (zero) error

--#

--# Tinme: 8760 us Iteration: 0 |Instance: /kbd tst
--# ** Failure: End of Sinmulation

--# Tinme: 8760 us Iteration: 0 |Instance: /kbd tst

Simulation script (ModelSim)

# kbd. do
# PS/2 Controller Sinulation Script

vlib work

vcom -93 PS2_Ctrl.vhd
vcom - 93 Kbd_Tst. vhd

vsi m kbd_t st

vi ew structure
vi ew signal s
do wkbd. do

run -a

Launch ModelSim, “Change Directory” to the project’s directory, and type “do kbd. do”.
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VHDL Code for the Simplest Application top-level

-- PS2sl MPL. vhd

-- Sinplest PS/2 application

LI BRARY i eee;
USE ieee.std_l ogic_1164. ALL;

Port ( Ck S In st
Reset o In st
D7SEG L : Qut st
D/7SEG H : Qut st

st
st
st

_vector (1to 7);
vector (1 to 7);

PS2 Data : In
PS2 dk : In
nLED . Qut

[sNeNeNesNeNeNe]

end PS2SI WPL;

conponent SEVENSEG
Port ( Data : in std_logic_vector (3 downto 0);
Pol : in std_logic;
Segout : out std_logic_vector (1 to 7) );
end conponent;
conmponent PS2_CTRL
Generic ( FILTERSIZE : POSITIVE := 8 );

Port ( Gk : in std_logic;

DoRead : in std_logic;

PS2_Cdk : in std_logic;

PS2_Data : in std_logic;

Reset : in std_l ogic;

Scan_Code : out std_logic_vector (7 downto 0);

Scan_DAV : out std_l ogic;

Scan_Err : out std_logic );

end conponent;

signal Gnd, Vcc :
signal LED
si gnal DoRead ;
signal Code vector (7 downto 0);
begin

Gd <= '0"; Vcc <="'1";

PS2_CTRL_i : PS2_CTRL
Generic Map ( FILTERSIZE => 8 )
Port Map ( O k=>0 k, Reset=>Reset, DoRead=>DoRead,
PS2_d k=>PS2_d k, PS2_Dat a=>PS2_Dat a,
Scan_Code=>Code, Scan_DAV=>DoRead, Scan_Err=>LED );

-- Note: use Pol=>Gnhd if display is active high type.
Dec7SegL : SEVENSEG
Port Map ( Data => Code(3 downto 0), Pol=>Vcc, Segout => DISEG L );

Dec7SegH : SEVENSEG
Port Map ( Data => Code(7 downto 4), Pol=>Vcc, Segout => D/SEG H );

nLED <= not LED; -- Note: renove the "not" if nLED is active high

end SCHEMATI C;

Note on VHDL style: in VHDL '93, it is possible to get rid of the component declaration, and avoid
Gnd and Vcc in the port map. On the other hand, the style above is very conservative and will be

accepted by all the synthesis tools.
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Conclusion

This small example is very simple and easy to understand, but it is based on principles that are
used for the most complex projects. The simulation Test Bench includes a number of nice tricks (like
for writing efficiently in the simulation transcript, for self-testing, for the automatic dimensioning of
tables, etc...).

If you decide to build a more sophisticated controller, you should find that the code provided is a
good basis. The self-testing test bench will also help you verify the non-regression.

The benefits of a good methodology (especially the efforts spent on the simulation) are visible, even
on a simple design as this one (which is basically a shift register).

Even the simplest code is prone to errors, and taking them out as early as possible in the design
flow is a great advantage.

If you need a more sophisticated controller, do not hesitate to contact us!

For other examples or other IPs, visit our Web site: ihitp://www.aise-fr.com/English.

Caveat Students!

If you have an assignment that is precisely a PS/2 interface, it would do you
no good to simply copy and paste from this project, even in the unlikely case
your teacher isn’'t aware of it.

If you persist in using this material, | strongly suggest that you very carefully
ignore the RTL code included (not even a glance, if possible) and the section
which describes its implementation.

You might try to understand and use the testbench, design your own solution,
verify that it simulates correctly, then only have a look at the provided RTL
code. You may afterwards find reasons to modify your own code; this is fine.

Since you have received a little help, you should add at least a timeout to
return to Idle state when the synchronization is lost (this is very easy) and
handle the x"FO” code.

Then, if you do not already have to, you could also add the communication in
the opposite direction (host to keyboard). This is slightly trickier.
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Appendix A
Scripts for specific FPGA/CPLD Boards

For the Lattice ispLSI / ispGDS Demo board, the free software “ispLEVER” is sufficient to
completely implement this simple design. The project is provided under the Lattice directory.

The synthesis is done by the OEM version of Synplify (but you can select Leonardo instead).
Note that the device selected is rather old (ispLSI1032) and requires some manual changes in the
ispTools installation to be accepted. We have a document indicating how to make these changes,
which is freely available upon request.

For the Xess XC40-010XL board, the device is not supported directly by recent versions of ISE.
This is why we included two Synthesis scripts that we've designed to ensure the proper VHDL
synthesis using either Leonardo Spectrum or Synplify. The “Project File’ for Synplify is in fact a
Tcl script... There is not much know-how in this script, see next page.

For Leonardo Spectrum, the script is a bit trickier. It has the advantage over a Project File (which is
not a Tcl script) to be path-independent. We use a few Tcl instructions to pick the current path and
use it to grab the VHDL source files:

puts ""

# Very sinple script for Leonardo Spectrum (c) ALSE

# Author : Bert Cuzeau

# Here, we target # a Xilinx XC4010XLpc84

# From Leonardo, sinply use "File > Run Script" comrand.

# G obal Cock timng constraints (12.5 MHz)
set register2register 80.0

set input2register 80.0

set register2output 80.0

set input2output 80.0

set synthdir [pwd]
set srcdir [file join ${synthdir} ..]
set fitdir $synthdir

_gc_read_init
_gc_run_init

set input_file_list "${srcdir}/sevenseg.vhd
${srcdir}/ps2_ctrl.vhd
${fitdir}/ps2sinpl.vhd "

set nodul e ps2si npl

set wire_table 4010xl-3_avg

set chip TRUE

set macro FALSE

set optimze_for area

set -hierarchy auto

set maxdel ay 0O

set hierarchy_auto TRUE

set hierarchy_preserve FALSE

set hierarchy _flatten FALSE

set report brief

set edif_wite_arrays TRUE

set output_file "${fitdir}/PS2sinpl.edf"

set novendor _constraint_file FALSE
set part 4010xl| PC84

set process 3

set pack_cl bs FALSE

set target Xxid4x

_gc_read
_gc_run

Leo_Script.tcl : Synthesis script for Leonardo Spectrum
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#-- Synplicity Project file
add_file -vhdl -1i
add_file -vhdl -1i
add_file -vhdl -1i

b work "../sevenseg.vhd"
b work "../ps2_ctrl.vhd"
b work "ps2sinpl.vhd"

#i npl ement ati on: " Xess"
i mpl -add Xess

#devi ce options

set _option -technol ogy XC4000XL
set_option -part XC4010XL

set _option -package PC384
set_option -speed_grade -3

#conpi | ati on/ mappi ng options

set _option -default_enum encodi ng onehot
set_option -synbolic_fsmconpiler 1
set_option -resource_sharing 1

#map options

set _option -frequency 12.000
set_option -disable_io_insertion O
set_option -force_gsr auto

#si mul ati on options
set_option -write_verilog O
set_option -wite_vhdl O

#automati c place and route (vendor) options
set_option -write_apr_constraint 0O

#set result format/file | ast
project -result_file "./ps2sinpl.edf"
impl -active "Xess"

Synplify. prj : Synplify Project File

The Xess sub-directory contains a specific top-level and the constraints file (ps2simpl.ucf) for the
XC40-010XL board. The top level does add a few pins and set them to a fixed logic level of ‘1’ to
ensure that the peripherals locate on the board (Ram and uP) will not create conflicts. Moreover,
since this board has only one LED digit (except when plug into an extension board), we display only
the low nibble of the scan code received. Download the bit file, plug a keyboard, and type !

The constraints are :

#NET CLK LOC=P13; # CLOCK FROM EXTERNAL OSCI LLATOR
# LED DRI VER QUTPUTS

NET D7SEG L(1) LOC=P19; # a
NET D7SEG L(2) LOC=P23; # b
NET D7SEG L(3) LOC=P26; # c
NET D7SEG L(4) LOC=P25; # d
NET D7SEG L(5) LOC=P24; # e
NET D7SEG L(6) LOC=P18; # f
NET D7SEG L(7) LOC=P20; # g
NET NLED LOC=P70; # Parallel Port status S3

# PS/ 2 Keyboard Connect or
NET PS2_CLK LOC=P68,;
NET PS2_DATA LOC=P69;

# DATA BI TS FROM THE PC PARALLEL PORT

NET RESET LOC=P46; # We use D2 as Reset

# RAM CONTROL PI NS

NET nCE LOC=P61; # ACTI VE- LOW QUTPUT ENABLE
NET nCE PULLUP;

NET nCE LOC=P65; # ACTI VE- LOW CHI P ENABLE
NET nCE PULLUP;

# M CROCONTROLLER PI NS

NET RST LOC=P36; # uC ACTI VE- H GH RESET

NET RST PULLUP;

PS2simpl.ucf for Xess XC40-010XL
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